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Before You Begin / Requirements for Core Impact

Before You Begin
Read this section before you install Core Impact.

Requirements for Core Impact

Operating Systems
The following operating systems are supported platforms for Core Impact 21.7. These 
platforms have also been tested and, although they are not certified, they are fully expected to 
provide a stable platform for Core Impact.

 l Windows 10
 l Windows 11
 l Windows Server 2016 Standard
 l Windows Server 2019 Standard

Databases
The following databases are supported platforms for Core Impact. These platforms have also 
been tested and, although they are not certified, they are fully expected to provide a stable 
platform for Core Impact.

 l SQL Server Express (included)
 l SQL Server 2014+ Standard or Enterprise
 l RDS Custom for SQL Server

Hardware
In addition to an accepted operating system, the below minimum requirements should be 
met:

 l Intel Core i5 (4th Generation)
 l 8 GB RAM
 l 4 GB Free Hard Disk Space (hard disk capacity requirements  increase with the 

quantity of high-volume test workspaces)
 l Internet Explorer 11.0 or later
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Before You Begin / Requirements for Core Impact

 l A Windows-compatible Ethernet networking card. Core Impact works  with wireless 
network interface cards.

 l Screen resolution: 1024 x 768 minimum (1280 x 1024 recommended)

Firewall
Impact connects to impact.coresecurity.com (54.233.152.201 and 54.207.98.104) and 
requires access through the firewall to ports 80 and 443 to perform the following actions:

 l Activation and Deactivation
 l Download Updates
 l Submit Crash Dumps (if crash happens)
 l Submit Usages Statistics (if enabled)

Please note the following important details about Core Impact:

 l In order to create a Fake Access Point using Core Impact, you must use a Pineapple 
Mark VII (https://shop.hak5.org/products/wifi-pineapple) wireless network auditing 
tool.

 l In order for you to install and use Core Impact, you must have Administrator privileges 
on the system.

 l Unless otherwise stated by a module or exploit, Core Impact is compatible to run on 
and target US English versions of the specified  operating systems only.

 l Connecting directly with a DSL/Cable modem using PPTP will limit some of the 
product's functionality (packet capture and custom packet crafting).
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Installing Core Impact Online / Installing Core Impact

Installing Core Impact Online
Follow these instructions to install Core Impact.

NOTE: 
If your environment is limited or restricted as to internet access, see Installing Core 
Impact Offline on page 12.

Installing Core Impact requires the following items and/or steps:

 l From the Fortra Customer Portal, download and run the Core Impact Product Installer 
(see Installing Core Impact on page 6).

 l (Optional) From the the Fortra Customer Portal, download and run the Third-party 
Add-on Installer (see Run the Third Party Add-on Installer on page 11).

 l From an email provided by Fortra, download and run the License Bundle Installer (see 
Licensing the Product on page 17).

 l Activate and Setup the product. This process (activation, database creation or 
migration, and setup) starts automatically the first time the product is run (see 
Activating the Product on page 19).

About Prerequisite Software

Starting with version 20.3, Core Impact can be installed on a different drive or in a custom 
directory. This option is presented in step 7 below. By default the Core Impact installer will 
always install prerequisite software (.NET, SQLServer, Information Server, and Crystal Reports 
Runtime) in their respective default locations before installing Core Impact. If you wish to 
also control where the prerequisite products are installed you must first manually install them 
using the steps outlined in the Offline install section and then install the base Core Impact 
product as described here.

Installing Core Impact
Core Impact is distributed as a self-installing Windows executable (.exe). If you are currently 
running an older version of Core Impact, you will be prompted to uninstall it before installing 
the latest version.
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NOTE: 
If you receive a warning that the installer cannot update your local firewall rules you 
should perform the following steps manually (in Windows Defender):

 l Add a inbound rule:
 o Name: Core Impact ICMPv4
 o Description: This rule is needed by Core Impact for ICMP Discovery and UDP 

portscanner
 o Protocol: ICMPv4

 l Add an exclusion for the "Core Impact Service" -Core Impact requires full access 
to the network -:

 o Exclude this file from the firewall analysis: 
C:\Program Files (x86)\Core Security\Impact\bin\impact_
core_com_exe.exe
(if you plan to install into a custom location, add an exclusion for that path)

 1.  Log in the Fortra Portal and download the installer from the Core Impact product 
download page.

 2. Save the distribution to a temporary directory and double click the CORE 
IMPACT.exe file. The installer will self-decrypt and start the installation wizard.

 3. Windows may prompt to allow the app to make changes. Press Yes to continue. 
A screen displays showing a preparation progress screen. 
You may also see different screens and notices flash on the screen as the following 
required software is installed:

 l Microsoft Visual C++ 2015-2019 Redistributable (x86)
 l Crystal Reports Runtime 13 SP 27
 l Microsoft Internet Information Services (IIS) 7.5 Express
 l Microsoft SQL Server 2014 SP3 Express RTM (x86 & x64Wow)

 4. When this completes, the Core Impact Setup Welcome screen displays. Press Next to 
continue.
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 5. In the License Agreement Window, read the product license for Core Impact. To 
accept the license, click the I accept the terms ... radio button and then click Next. If 
the license is not accepted, Core Impact will not install.

 6. Antivirus software will interfere with the installation of Core Impact and may interfere 
with Core Impact's operation. This page of the wizard is a reminder to disable 
antivirus scanners during installation.
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WARNING: 
Temporarily disable antivirus scanners during installation and then exclude either 
the following Core Impact default installation directories (if you plan to install 
here) from your antivirus tool's scanning locations:

 l %ProgramData%\IMPACT
 l c:\Program Files\Core Security (on 32-bit operating systems)
 l c:\Program Files (x86)\Core Security (on 64-bit operating systems)

or
 l the custom location specified in the next step (if you choose a custom 

location)
If Controlled Folder Access is enabled, MS IIS Express will be prevented to run, 
unless an exception is added for it in the Windows Defender Security App using 
these steps:

 1. Open Windows Security.
 2. In Ransomware protection, go to Manage ransomware protection.
 3. Enable Controlled folder access, if disabled.
 4. Go to Allow an app through controlled folder access.
 5. Select Add an allowed app and follow the prompts to add apps.

Check the Antivirus has been configured box and press Next to continue.
 7. Select the Installation Type.
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Default - This will install into Windows default directories.
Custom - Select to specify a different drive or custom directory. In the Custom 

Installation panel use the Browse button to navigate to the desired location for 
the install.

NOTE: 
 If you wish to also control where the prerequisite products are installed you 
must first manually install them using the steps outlined in the Offline install 
section and then install the base Core Impact product.

Press Next to continue.
You will see a progress screen as the software is copied and configured.

 8. The wizard will notify you when the installation is complete.
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 9. Click the Finish button.                                    

Run the Third Party Add-on Installer
After installing Core Impact, install the 3rd party software program provided by Core Security. 
Simply follow the prompts and allow the required third party application to install. This 
installer can be downloaded from the Fortra Portal, Core Impact product download page and 
can be run before or after running the License Bundle Installer.

Core Impact is now installed. Proceed to the section Licensing the Product on page 17.
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Installing Core Impact Offline
The Core Impact installer is designed to automatically download and install any missing 
prerequisites. This process can break when Core Impact is installed in an offline environment 
(with no connection to the Internet).

This section lists the required software to install Core Impact by operating system, including 
software download links and command line switches to install the applicable software. 

Notes

 l Installation instructions for Windows server versions should follow the criteria for the 
workstation versions based on Windows Server 2016 – installation requirements of 
Windows 10.

 l For some operating systems, multiple versions of Microsoft .NET Framework (3.5 SP1 
and 4.0) are required.

 l Microsoft SQL Server Express 2022 is installed in clean environments from Core 
Impact 21.7 by default. To upgrade from SQL Server Express 2014 to SQL Server 
Express 2022 for existing versions of Core Impact, see Upgrading to SQL Server 
Express 2022 on page 15.

TIP: 
Follow these instructions in the order they are listed to install Core Impact as some 
prerequisites require the existence of other prerequisite items.

For Windows 10 (x64)

Install Microsoft Visual C++ 2022 Runtime Libraries
 1. Download Microsoft Visual C++ 2022 Runtime Libraries installer.
 2. Run the following command:

VC_redist.x86.exe /q /norestart

Install Npcap v1.80
 1. Download Npcap v1.80.
 2. Run the following command:
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npcap-1.80-oem.exe /loopback_support=no /admin_only=yes /dot11_
support=no /require_features

Install Microsoft .NET Framework 4.8 Runtime
NOTE: 
The installation requires either an Internet connection or access to the Windows 10 install 
media.

Depending on whether or not you have an Internet connection, choose one of the following 
installation options:

 A. Install with an Internet connection:
 1. Run the Core Impact installer. It will detect whether the Microsoft .NET 

Framework 4.8 Runtime is missing, then download and install it if needed.
or

 2. Use the following alternate method:
 i. Open the Control Panel and go to Programs and Features.

 ii. Select the Turn Windows features on or off link.
 iii. Select the .NET Framework 4.8 Advanced Services check box.

 B. Install without an Internet connection:
 1. Download the .NET Framework v4.8 Runtime.
 2. Run the downloaded executable and follow the installation wizard.

Install Microsoft SQL Server Express 2022
 1. Download Microsoft SQL Server Express 2022.
 2. Run the following command:

SQLEXPR_2022_x64_ENU.exe /QS /HIDECONSOLE /ACTION=Install 
/IACCEPTSQLSERVERLICENSETERMS /FEATURES=SQL /INSTANCENAME=IMPACT 
/AGTSVCACCOUNT="NT AUTHORITY\NETWORK SERVICE" /SQLSVCACCOUNT="NT 
AUTHORITY\NETWORK SERVICE" 
/SQLSYSADMINACCOUNTS="BUILTIN\Administrators"

Install Microsoft SQL Server Native Client 11
 1. Download Microsoft SQL Server Native Client 11.
 2. Run the follow command:

sqlncli.msi /passive IACCEPTSQLNCLILICENSETERMS=YES
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Install Microsoft Internet Information Server 10 Express
 1. Download Microsoft Internet Information Server 10 Express.
 2. Use the following command line switch: 

iisexpress_amd64_en-US.msi /qn REBOOT=ReallySuppress

Install Crystal Reports Runtime 13 SP27
 1. Download Crystal Reports Runtime 13 SP27.
 2. Use the following command line switch:

CR13SP27MSI32.MSI /qn REBOOT=ReallySuppress

TIP: 
If you want to specify a different install directory use the following command line 
switch instead:
/qn REBOOT=ReallySuppress INSTALLDIR="<path_where_to_install_
the_product>"
As an example, to install into D:\CustomePath
CR13SP27MSI32.MSI /qn REBOOT=ReallySuppress 
INSTALLDIR="D:\CustomPath"

Install Microsoft Edge WebView2
 1. Go to Microsoft Edge WebView2.
 2. Select Download.
 3. Download and run the Evergreen Standalone Installer that matches your system 

architecture.

Install Core Impact 3rd Party Packages (optional)
The download link and passphrase for this package is provided in the email sent by Core 
Security with your Core Impact distribution download links.

After you complete the preceding offline steps, run the base Impact installer described in 
Installing Core Impact on page 6.
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Upgrading to SQL Server Express 2022 / Export current workspace

Upgrading to SQL Server Express 
2022
Microsoft SQL Server Express 2022 is installed in clean environments from Core Impact 21.7 
by default. To upgrade from SQL Server Express 2014 to SQL Server Express 2022 for 
existing versions of Core Impact, do the following:

Export current workspace
NOTE: If SQL Server Express 2014 is used as the main product database, follow this step. 
Otherwise, skip this step and go to Uninstall SQL Server Express 2014 on page 15.

From Core Impact, go to File > Import/Export Workspaces and then follow the wizard:

 1. Click Next.
 2. Leave Impact’s Database as the data source.
 3. Click Next.
 4. Select all workspaces.
 5. Click Next.
 6. Select Microsoft SQL Server as the data destination, and then click the … button to 

export the .mdf file.
 7. Click Next.
 8. Once the workspaces are exported, click Finish.

Uninstall SQL Server Express 2014
From the Control Panel, uninstall Microsoft SQL Server 2014. Once the uninstall process is 
complete, you may need to restart the system.

Install Microsoft SQL Server Express 2022
 1. Download Microsoft SQL Server Express 2022.
 2. Run the following command:
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SQLEXPR_2022_x64_ENU.exe /QS /HIDECONSOLE /ACTION=Install 
/IACCEPTSQLSERVERLICENSETERMS /FEATURES=SQL /INSTANCENAME=IMPACT 
/AGTSVCACCOUNT="NT AUTHORITY\NETWORK SERVICE" /SQLSVCACCOUNT="NT 
AUTHORITY\NETWORK SERVICE" 
/SQLSYSADMINACCOUNTS="BUILTIN\Administrators"

Import workspaces
From Core Impact, go to File > Import/Export Workspaces and then follow the wizard:

 1. Click Next.
 2. Select Microsoft SQL Server as the data source, and then select the .mdf file you 

exported in step 6 of Export current workspace on page 15.
 3. Click Next.
 4. Select all workspaces.
 5. Click Next.
 6. Select Impact’s Database as the data destination.
 7. Click Next.
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Licensing the Product
Fortra will send an email containing a link to the License Bundle installer along with a 
licensing passphrase to be applied during the install (step 1 below).

WARNING: 
You will see a licensing error if you attempt to run Impact before applying the license 
outlined in the steps below.

Steps

 1. Download the License Bundle installer and save it locally. Once saved, locate and 
double-click to start the install. 
The Passphrase screen displays.

Paste the passphrase from the email and press Decrypt.
 2. Windows may prompt to allow the app to make changes. Press Yes to continue.:

At the Ready to Install screen press Install to start.

You will see a progress screen as the software is copied and configured. 
 3. The wizard will notify you when the installation is complete.
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Licensing the Product /

 4. Press the Finish button to close the installer, 
or
check the Launch option and press Finish to start Core Impact

NOTE: 
The first time Core Impact starts you will be prompted to activate the product. 
(see Activating the Product on page 19 for these steps.)

Now that Impact is installed and licensed, see to the section Activating the Product on page 
19.
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Activating the Product
The first time you run Core Impact on a new computer you will be presented with the 
Activation Wizard. You must activate Core Impact in order for it to operate.

 1. When the Activation Wizard opens, press Next to continue.

 2. Select Activate automatically ... if you want to activate over the Internet.
or
 Select Activate via telephone or email if you don't have an active Internet connection.
Press Next to continue.
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 3. Select Machine Name and Currently logged in username, or a Friendly Name to be 
submitted to Core Security as a part of the activation process. This will simplify the 
management of your contract and improve the response time in case of an activation 
issue. 
Press Next to continue.

 4. If you have an active Internet connection on the computer where Core Impact is 
installed, the product can activate automatically through the network. Core Impact will 
connect to the Internet based upon settings that you enter during the activation 
process. Select one of the following options to configure Core Impact to:

 l Use Internet Explorer settings: This is the default setting and assumes that you 
configure your Internet connection via Internet Explorer's Tools > Internet 
Options > Connections form.

 l Use a Direct connection to the Internet
 l Use a proxy server

If the computer on which you are installing Core Impact does not have an active 
connection to the Internet, you can activate the product via email or by phone. The 
Activation Wizard will present you with a Reference Code specific to the computer on 
which Core Impact is running. Please contact Core Security via email or phone with 
the code referenced in the Wizard (see Contact Support for contact information) and 
you will be given an Activation Key to activate the product.
Press Next to continue.
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Activating the Product /

 5. You will see the following progress screen as the software is activating.
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 6. The wizard will notify you when the activation is complete.

 7. Press the Finish button.

Database Creation Wizard
If you are installing Core Impact for the first time on a machine, the Database Creation Wizard 
will automatically begin when you launch Core Impact. 

 1. When the Database Creation Wizard opens, press Next to continue.

 2. Impact supports three databases:
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 l SQL Server Express (default)
 l An existing instance of SQL Server Standard/Enterprise (2014+)
 l RDS Custom for SQL Server.

Select Default (local SQL Express) or  Custom (SQLServer Standard/Enterprise or RDS 
Custom for SQL Server) and provide Host, Instance and Credentials if you want a 
trusted connection. You can also choose to Encrypt the connection.
Press Next to continue.

NOTE: 
This setting can be modified in product Database Options, after the installation 
has completed. (see the Core Impact User Guide for additional considerations 
regarding Integrated Windows Authentication) 

 3. The wizard will notify you when the DB is created or configured.
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Activating the Product / Database Migration Wizard

 4. Press the Finish button.

Database Migration Wizard
If you install Core Impact after having an older version, the Database Migration Wizard will 
upgrade your database(s). If it is a brand new install of Core Impact, the Database Migration 
Wizard will create a database for you. 

When the Database Migration Wizard opens, press Next to continue and follow the on-screen 
prompts to complete the migration process.

The wizard will notify you when the migration is complete.
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Set Up Core Impact
When you first launch Core Impact, the Setup Wizard will open and allow you to set network 
configurations and community usage preferences. Network settings can be changed at any 
time by accessing the Network Options in the Setting Console Options chapter of the Core 
Impact User Guide. Community usage preferences can also be modified by accessing 
Community Usage Options (these are in the same chapter).

 1. When the Setup Wizard opens, press the          Next button.

 2. Select your preferred Network Interface from the drop-down menu, then press the 
Next button.
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 3. Define how your system connects to the Internet. If you Use a proxy server, enter your 
proxy's connection details, then press the Nextbutton.

 4. Core Impact provides the ability to connect to the Core CloudCypher, which is a web-
based service that attempts to determine the plain text passwords for discovered 
NTLM Hashes from Windows machines. From the Automatically Submit Credentials 
drop down, select one of the following options:

 l Yes: Hashes will be automatically submitted to the CloudCypher service.
 l No: Hashes will not be automatically submitted to the CloudCypher service. You 

will still be able to submit them manually.
 l Never: The ability to send hashes to the CloudCypher service will not be available 

in your current installation of Core Impact.
If you choose either Yes or No, you can modify this setting in the Core CloudCypher 
Options (in the Core Impact User Guide) section of the Preferences, after the 
installation has been completed.
You can also enter an email address to which notifications will be sent when a 
cracking process has completed.
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Press Next to continue.
 5. Generated reports will be saved to the default path displayed. Press Next to continue.

This value can be changed later in the products Other Options. (see the User Guide)
 6. Core Impact can gather anonymous usage statistics about how the application is 

used. This allows Core Security to provide industry statistics to you as well as to 
improve Core Impact for future releases. To opt into the Usage Statistics Program, 
click the Yes, I am willing to participate ... checkbox, optionally select your primary 
industry from the drop-down. 
If you check I wish to permanently opt-out of the program, your statistics will not be 
gathered and you will not have the option to enable usage statistics in Core Impact.
If you do not check either option, your statistics will not be gathered unless you enable 
statistics in the Community Usage Options in Core Impact.
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 7. Press the Finishbutton.
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After You are Done
Congratulations! Core Impact is now installed, licensed and activated. Read the following for 
additional information and your next steps.

Next Steps
The following topics in the Core Impact User Guide appendix are available to review:

 l How to Integrate with Metasploit
 l Transferring a Core Impact Installation
 l Usage Statistics
 l Uninstalling Core Impact
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